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About ODBC Manager

The Leading Edge is pleased to release version 1.1 of ODBC Manager - a comprehensive ODBC tool 
for both application developers and database users. ODBC Manager's strong UI, context sensitive help,
high performance engine and feature-rich set of integrated ODBC tools make it a leader in the domain 
of ODBC tool suites.
Here's a small list enumerating some of the features provided by ODBC Manager:

Complete ODBC Level 2 support

Spy/Trace Functionality
Per task or multiple tasks
Time per ODBC API
Per ODBC API or multiple ODBC API's
ODBC API arguments
Core, Level 1 and Level 2 ODBC API's
Able to display up to 999,999,999 rows of trace information and output an unlimited rows of trace 

information to disk 
16 bit Windows support only (32 bit support for NT and Windows95 will be available in Release 2,

scheduled to be released in Q3, 1995 simultaneously with the release of Windows95)

Comprehensive Spy/Trace Analysis

Fast & Simple Ad-Hoc ODBC query functionality
Save and open existing queries (*.sql files) capable of containing multiple SQL commands
Able to display up to rows 999,999,999 by    999,999,999 columns of data for select queries

Complete Driver information for each ODBC data source

Full database table & column information
All system tables, views, aliases and synonyms including privileges
Detailed information about all columns in each table in the current data source
Foreign & Primary keys (ODBC Level 2)
References from a given column (ODBC Level 2)
References to a given column (ODBC Level 2)

Full Clipboard support, file-save and file-print

No source code modification is required to use any of the functions provided by the ODBC 
Manager



Technical Support

Technical support is available to registered owners of ODBC Manager. Support is provided by e-mail, or
CompuServe on a 24 hour turnaround basis.

Support Method Contact
Internet edge@wchat.on.ca
CompuServe 76311,1426



Ordering ODBC Manager

ODBC Manager costs $359 (Canadian funds) including all taxes. Shipping costs are extra and vary 
depending on the shipping method used. For further details on ordering ODBC Manager, including 
shipping options, open the order form from the ODBC Manager program group on you desktop or click 
on the icon below.



Query Edit Pane

The Query Edit Pane is located at the bottom of the ODBC Manager window. It is used to display SQL 
commands which may then be executed using the Execute Query command. Commands in this pane 
can either be manually typed, selected from the Query Command History List, or loaded from an 
external file. Compound SQL statements can be entered here and executed with a single execute 
command.



Results Pane

The Results pane is located above the Query Edit pane in the ODBC Manager window. It is used to 
display results of SQL commands executed from the Query Edit pane. For example, the results of an 
attempt to connect to a data source may would indicate whether the connection succeeded of failed.



Select Query Pane

The Select Query pane is located below the Trace pane in the ODBC Manager window. It is used to 
display the results of a Select command. The status of the Fetch All Rows On Select dictates whether 
ODBC Manager will fetch all records which satisfy a Select command or only enough records to fill the 
pane.



Trace Pane

The Trace Pane is located at the top of the ODBC Manager window. It is used to display information 
generated by a trace. The criteria which trace information must satisfy are specified in the Trace 
Options dialog. 



File menu commands

The File menu offers the following commands:
Command Action
Save... Saves ranges or entire sections of

data.
Print... Prints ranges or entire sections of

data.
Open Query... Opens an existing query.
Save Query... Saves a query to a file.
Exit Exits ODBC Manager.



Save... command (File menu)

Use this command to save ranges or entire sections of data. Choosing this command displays the 
Output Options dialog. After selecting the required output options, the name and location of the output 
file can be specified in the Save dialog. 

Shortcuts

Toolbar:
Keys: CTRL+S



Print... command (File menu)

Use this command to print ranges or entire sections of data. Choosing this command displays the 
Output Options dialog. After selecting the required output options, printing preferences can be specified 
in the Print dialog. 

Shortcuts

Toolbar:
Keys: CTRL+P



Open Query... command (File menu)

Use this command to open an existing query. Choosing this command displays the File Open dialog in 
which a previously saved file can be selected. An opened query can consist of a compound SQL 
statement.

Shortcuts

Toolbar:
Keys: ALT+O



Save Query... command (File menu)

Use this command to save the information in the Query Edit pane.. Choosing this command displays 
the File Save As dialog in which the name and location of the output file can be specified. A saved 
query can consist of a compound SQL statement.

Shortcuts

Toolbar:
Keys: ALT+S



Exit command (File menu)

Use this command to end your ODBC Manager session. You can also use the Close command on the 
application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Edit menu commands

The Edit menu offers the following commands:
Command Action
Undo Reverse previous editing 

operation.
Cut Deletes data from a window and 

moves it to the clipboard.
Copy Copies data from a window to the 

clipboard.
Paste Pastes data from the clipboard 

into a window.
Font... Allows you to replace the current 

font with any other installed font.
Find... Allows you to find a string of text.
Find Next Finds the next occurrence of a 

text string.



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data from a window and put it on the clipboard. 
This command is only available in the Results pane and the Query Edit pane. It is unavailable if there is
no data currently selected.
Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. This command is unavailable if there is no 
data currently selected.
Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Toolbar:

Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Font... command (Edit menu)

Use this command to replace the current font with any other installed font. Choosing this command 
displays the Font dialog.



Find... command (Edit menu)

Use this command to find instances of a text string in either the Trace pane and the Select Query pane. 
Choosing this command displays the Search dialog.

Shortcuts
Keys: ALT+F3



Find Next command (Edit menu)

Use this command to find the next instance of the command specified in the Search dialog. for the 
specified pane. This command is unavailable if a string has not been entered in the Search dialog.

Shortcuts
Keys: CTRL+F3



View menu commands

The View menu offers the following commands:
Command Action
Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Row Numbers Shows or hides row numbers.
ODBC 
Administrator

Launches the Microsoft ODBC 
Administrator

Next Pane Moves the focus to the next 
pane.

Previous Pane Moves the focus to the previous
pane.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most 
common commands in ODBC Manager, such as File Open. A check mark appears next to the menu 
item when the Toolbar is displayed.
See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar 
provides quick mouse access to many tools used in ODBC Manager,
To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To
Print trace output
Save trace or query output
Start a trace
Pause a trace
Stop a trace
Display and change trace options
Analyze trace data
Clear the trace output pane
Display the time taken by each 
API
Display the arguments passed by 
each API
Display the codes returned by 
each API
Connect to a data source
Disconnect from the current data 
source
Execute the SQL query in the 
Query Edit pane
Commit the current transaction
Rollback the last transaction
List tables for the current data 
source
List the queries previously carried
out
Display driver information about 
the current ODBC driver



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next 
to the menu item when the Status Bar is displayed.
See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the ODBC Manager window. To display or hide the status 
bar, use the Status Bar command in the View menu (ALT, V, S).
The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus. This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them. If after viewing the description of the toolbar button command you
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.
The middle area of the status bar gives information about the current ODBC driver including the name 
of the driver being used to communicate with the current data source, its ODBC conformance level, and
whether it supports single or double quotes in queries.
The right area of the status bar identifies which of ODBC Managers four panes is currently focused.



Row Numbers command (View menu)

Use this command to display and hide row numbers. Row numbers can be displayed in both the Select 
Query pane and the Trace pane. Displaying the row numbers in the Trace pane shows the total number
of trace statements executed. Row numbers in the Select Query pane reveal the total number of rows 
which satisfy the last ODBC statement executed.



ODBC Administrator command (View menu)

Use this command to launch the Microsoft ODBC Administrator. Initially a list of data sources and their 
corresponding drivers is displayed allowing you to configure, add and delete data sources. The ODBC 
Administrator executable (odbcadm.exe) must be on your path to avail of this function.



Next Pane command (View menu)

Use this command to move the focus to the next pane. Repeating this command will move the focus 
cyclically from the Trace pane to the Select Query pane to the Results pane to the Query Edit pane. 
and back to the Trace pane.

Shortcuts
Keys: F6



Previous Pane command (View menu)

Use this command to move the focus to the previous pane. Repeating this command will move the 
focus cyclically from the Query Edit pane. to the Results pane to the Select Query pane to the Trace 
pane and back to the Query Edit pane.

Shortcuts
Keys: SHIFT+F6



Trace menu commands

The Trace menu offers the following commands, which enable you to control the flow of trace 
information and analyze its content:

Command Action
Start Starts the current trace.
Pause Pauses the current trace.
Stop Stops the current trace.
Options... Allows you to specify the trace 

options.
Trace Analysis... Allows you to analyze the results 

of a trace.
Clear Trace Pane Clears the Trace pane.
Time Each API Displays the time spent by each 

API.
Return Codes from 
Each API

Displays the codes returned by 
each API.

Arguments for 
Each API

Displays the arguments passed 
by each API.



Start command (Trace menu)

Use this command to start the current trace. This command is unavailable if no task has been selected 
in the Trace Options dialog.

Shortcuts
Toolbar:

Keys: F2



Stop command (Trace menu)

Use this command to stop the current trace. This command is unavailable if there is no trace currently 
running.

Shortcuts
Toolbar:

Keys: F3



Pause command (Trace menu)

Use this command to pause the current trace. This command is unavailable if there is no trace currently
running.

Shortcuts
Toolbar:

Keys: F4



Options... command (Trace menu)

Use this command to display the Trace Options dialog. The Trace Options dialog allows you to specify 
the SQL commands which the trace will trap, the format in which the trace will display, the tasks for 
which the trace will apply and, if required, files to which the trace will be logged.

Shortcuts
Toolbar:

Keys: CTRL+O



Trace Analysis... command (Trace menu)

Use this command to display the Trace Analysis dialog. The Trace Analysis dialog allows you to analyze
the time taken by each task for each API and highlight specific types of information.

Shortcuts
Toolbar:

Keys: CTRL+A



Clear Trace Pane command (Trace menu)

Use this command to clear the Trace pane.

Shortcuts
Toolbar:

Keys: CTRL+B



Time Each API command (Trace menu)

Use this command to display or hide the column which shows the time taken by each ODBC statement 
executed. The information is displayed in the Trace pane..

Shortcuts
Toolbar:



Return Codes from Each API command (Trace menu)

Use this command to display or hide the column which shows the codes returned by each ODBC 
statement executed. The information is displayed in the Trace pane..

Shortcuts
Toolbar:



Arguments for Each API command (Trace menu)

Use this command to display or hide the column which shows the arguments passed by each ODBC 
statement executed. The information is displayed in the Trace pane..

Shortcuts
Toolbar:



Query menu commands

The Query menu offers the following commands:
Command Action
Connect... Connects to a data source.
Disconnect Disconnects the current data 

source.
Execute Query Executes a SQL query command.
List Tables... Lists the tables in the current data

source.
Command 
History...

Lists the SQL query commands 
previously executed.

Display Driver 
Info...

Displays information about the 
current ODBC driver.

Driver ODBC Data 
Types

Displays information about the 
ODBC data types for the current 
driver.

Fetch All Rows On 
Select

Fetches either all rows or only 
enough rows to fill the Select 
Query pane on execution of a 
select query.

Next SQL 
Command

Executes the next command in 
the Query Command History List.

Previous SQL 
Command

Executes the previous command 
in the Query Command History 
List.

Autocommit Enables the autocommit option 
which automatically commits 
transactions after execution.

Commit 
Transactions

Commits the current transaction.

Rollback 
Transaction

Rolls back the last transaction.



Connect... command (Query menu)

Use this command to display the ODBC Data Source Connect dialog. The ODBC Data Source Connect
dialog allows you to connect to one of the data sources on your system. This command is unavailable if
there currently is a connection to a data source. New ODBC data sources can be defined through the 
ODBC Administrator.
After a connection has been attempted, the Results pane shows the results of an attempt to connect to 
a data source and can be used to identify the cause of a failed connection.

Shortcuts
Toolbar:

Keys: CTRL+F2



Disconnect command (Query menu)

Use this command to disconnect the currently connected data source. This command is unavailable if 
there currently is no connection to a data source.

Shortcuts
Toolbar:

Keys: CTRL+F4



Execute Query command (Query menu)

Use this command to execute the SQL query in the Query Edit pane. This command is unavailable if 
there is no text in the Query Edit Pane. Compound SQL statements can be executed with a single 
execute command.

Shortcuts

Toolbar:
Keys: F9



List Tables... command (Query menu)

Use this command to display the Data Source Tables dialog. The Data Source Tables dialog allows you 
to view information about the tables in the currently connected data source. The privileges for each type
of ODBC operation on a particular table for each type of user are also displayed in this dialog. This 
information is only accessible if the current data source is ODBC Level 2 compliant.

Shortcuts

Toolbar:
Keys: CTRL+L



Command History... command (Query menu)

Use this command to display the Query Command History List. The Query Command History List 
dialog lists all of the ODBC (SQL) statements that have been executed in the current session. If the 
current session has just started, the last 10 statements (if applicable) from the previous session are 
listed.

Shortcuts

Toolbar:
Keys: CTRL+R



Display Driver Info... command (Query menu)

Use this command to display the Current ODBC Driver Information dialog. The Current ODBC Driver 
Information dialog allows you to view details about the currently installed ODBC driver.
The information displayed is all information available through SQLGetInfo. ODBC Manager supports the
complete set of #defines as defined in ODBC 2.1

Shortcuts

Toolbar:
Keys: CTRL+I



Driver ODBC Data Types... command (Query menu)

Use this command to display the ODBC Data Types dialog. The ODBC Data Types dialog shows details
about the ODBC data types for the current ODBC driver.

Shortcuts
Keys: CTRL+D



Fetch All Rows on Select command (Query menu)

Use this command to immediately fetch all the data which satisfies a Select command when it is 
executed. If this option is not selected, ODBC Manager will only fetch enough records to fill the Select 
Query pane As the Select Query pane is scrolled, additional records will be fetched to fill the pane
Selecting this option will potentially make the initial fetch quite slow but will result in faster scrolling of 
the resulting data.



Next SQL Command command (Query menu)

Use this command to execute the next command in the Query Command History List. This command is
unavailable if the current command is the last command in the list.

Shortcuts
Keys: CTRL+N



Previous SQL Command command (Query menu)

Use this command to execute the previous command in the Query Command History List. This 
command is unavailable if no command has been previously executed.

Shortcuts
Keys: CTRL+P



Autocommit command (Query menu)

Use this command to automatically commit transactions after SQL commands are executed. If 
Autocommit is not enabled, the Commit Transaction command must be used to commit transactions. 
This command is useful for transaction control.



Commit Transaction command (Query menu)

Use this command to commit the current transaction. This command is unavailable if Autocommitment 
has been enabled.

Shortcuts
Toolbar:



Rollback Transaction command (Query menu)

Use this command to rollback the last transaction. This command is unavailable if Autocommitment has
been enabled.

Shortcuts
Toolbar:

Keys: CTRL+V



Help menu commands

The Help menu offers the following commands, which provide you assistance with this product and 
further information: 

Command Action
Contents Use this command to display the 

opening screen of Help.
Ordering 
Information...

Use this command to find out how
to order ODBC Manager.

Using Help... Displays instructions for using 
Help.

Obtaining Technical
Support...

Use this command to find out how
to contact The Leading Edge for 
technical support.

About ODBC 
Manager...

Use this command to display the 
ODBC Manager copyright and 
version information.



Contents command... (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to 
step-by-step instructions for using ODBC Manager and various types of reference information. 
Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Ordering Information... command (Help menu)

Use this command to find out how to order ODBC Manager.



Using Help... command (Help menu)

Use this command for instructions about using Help.



Obtaining Technical Support... command (Help menu)

Use this command to find out how to contact The Leading Edge for technical support.



About ODBC Manager... command (Help menu)

Use this command to display the ODBC Manager copyright and version information.



Title Bar

The title bar is located along the top of a window. It contains the name of the application and document.
To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their title 
bars.
A title bar may contain the following elements:

Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll 
bars indicate your vertical and horizontal location in the document. You can use the mouse to scroll to 
other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow 
keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move. 
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.
Note: This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box 
with the arrow keys.

Note: This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the ODBC Manager window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window. ODBC Manager determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window. ODBC Manager determines which
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.
Double-clicking a Control-menu box is the same as choosing the Close command.

Note: If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time. You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the ODBC Manager window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar. This option does not affect 
applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap. This option does not affect applications 
reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Print dialog

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection. Choose the Setup option to change the printer and 
printer connection.

Setup
Displays the Print Setup dialog box, so you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you 

specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing. Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that ODBC Manager is sending output to the printer. 
The page number indicates the progress of the printing.
To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed. When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages
will be displayed in their printed format. The print preview toolbar offers you options to view either one 
or two pages at a time; move back and forth through the document; zoom in and out of pages; and 
initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use. Choose the Default Printer; or choose the Specific Printer option and
select one of the current installed printers shown in the box. You install printers and configure ports 
using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Columns In Table dialog

This dialog, displayed by clicking the Columns... button in the Data Source Tables dialog shows the 
attributes of the columns in the selected data source table.

Column Name
Lists the columns in the selected data source table. Choosing different columns affects the data 
displayed in the other fields of this dialog.

Column No.
Identifies the position that the selected column occupies within the selected table.

Table Owner
Identifies the owner of the selected table; NULL if not applicable to the data source.

Data Type
Displays the ODBC SQL data type of data fields in the selected column.

Type Name
Data source-dependent data type name; for example, VARCHAR, MONEY, or CHAR.

Precision
Identifies the precision of the data type used in the selected column.

Length
Identifies the transfer size data in the selected column. If the data is numeric, the length may be 
different than the size of the data stored on the data source. For binary or character data, the length is 
the same as the precision.

Scale
Displays the scale of data fields in the selected column.

Radix
Displays the radix of data fields in the selected column.

Nullable

Identifies whether or not a column is nullable.

Remarks
Displays a description of the selected column.



ODBC Data Source Connect dialog

The ODBC Data Source Connect dialog, displayed by selecting the Connect... command from the 
Query menu, allows you to connect to any databases currently on your system. If the data source 
requires you to specify a name and password, entering incorrect information will cause the connection 
to fail.

Data Source
Select one of the data sources defined on your system.

Name
Enter your user name. A user name can contain up to eight characters.

Password
Enter your password. A password can contain up to eight characters and will be displayed in hidden 
format (*).



Data Source Tables dialog

This dialog, displayed by selecting the List Tables... command from the Query menu, allows you to view
information about the tables in the currently connected data source.

Table Name
Displays a list of all of the tables stored in the current data source. Select one of the data sources 
defined on your system. The tables listed can be restricted to one or any combination of the following:

Table
Views
System Tables
Alias (correlation names)
Synonyms

Table Privileges
Summarizes the privileges associated with each table. Privileges are categorized by user (e.g., 
PUBLIC, SYSTEM etc.) and operation (e.g., SELECT, UPDATE, DELETE, INSERT, or REFERENCES)

Columns...
Displays the Columns in Table dialog which allows you view information about the columns in the 
selected table.

Primary Keys...
Displays the Primary Keys dialog which summarizes the columns comprising the primary keys 
associated with the selected table. This information is only accessible if the current data source is 
ODBC Level 2 compliant.

Referenced By...
Displays the Foreign Keys dialog which, if foreign keys exist, shows a detailed summary of column 
names comprising the foreign keys that refer to the primary key of the selected table. The properties of 
these columns are also displayed. This information is only accessible if the current data source is 
ODBC Level 2 compliant.
Refer to your database manual to see how constraints on foreign keys can by applied to database 
tables.

References...
Displays the Foreign Keys dialog which shows a detailed summary of all of the primary keys that are 
related to foreign keys in the selected table. These are the table and column names that comprise the 
primary key associated with each foreign key in the foreign keys table. This information is only 
accessible if the current data source is ODBC Level 2 compliant.



Primary Key dialog

This dialog, displayed by choosing a table and selecting the Primary Keys... button in the Data Source 
Tables dialog, displays the column names that comprise the primary key for the selected table. This 
information is only accessible if the current data source is ODBC Level 2 compliant.

Column Name
Lists the columns in the primary key for the selected data source table. Choosing different columns 
affects the data displayed in the other fields of this dialog.

Name
Primary key table identifier.

Owner
Primary key table owner identifier; NULL if not applicable to the data source.

Qualifier
Primary key table qualifier identifier; NULL if not applicable to the data source.

Key Seq.
Column sequence number in key. The first number in the sequence is 1.



Foreign Keys To Table dialog

This dialog, displayed by choosing a table and selecting one of the following buttons:
Referenced By... button in the Data Source Tables dialog. A detailed summary of column names 

and their properties comprising the foreign keys that refer to the primary key of the selected table, if 
foreign keys exist.

References... button in the Data Source Tables dialog. A detailed summary of column names 
which makes up the foreign keys in the selected table. These columns refer to the primary keys in other 
tables.

Primary Key Table/Foreign Key Table
When activated by the Referenced By... button, the Primary Key Table is the table selected in the Data 
Source Tables dialog. The list on the left summarizes tables which have foreign keys to the primary key 
table. In this context, the Foreign Key Table provides details about the columns in the foreign key table 
which references the Primary Key Table.
When activated by the References... button, the list on the left summarizes the tables that are 
referenced by the selected table. The Primary Key Table details the columns in those tables that 
represent the primary keys. The Foreign Key Table provides details about the columns in the selected 
table which makes up the foreign keys.

Key Sequence
Defines the columns sequence number in key (starting with 1).

Update Rule
Actions which can be applied to the foreign key when the SQL operation is UPDATE. Possible values 
are:

SQL_CASCADE=0
SQL_RESTRICT=1
SQL_SET_NULL=2
NULL if not applicable to the data source

Delete Rule
Actions which can be applied to the foreign key when the SQL operation is DELETE. Possible values 
are:

SQL_CASCADE=0
SQL_RESTRICT=1
SQL_SET_NULL=2
NULL if not applicable to the data source



Describe Column dialog

This dialog, displayed by right mouse clicking on a column heading in the Select Query pane, allows 
you to view information about the selected column.

Column Number
Identifies the number of the selected column.

Column Name
Identifies the name of the selected column.

ODBC SQL Data Type
Displays the ODBC SQL data type of data fields in the selected column.

Precision
Identifies the precision of the data type used in the selected column.

Scale
Displays the scale of data fields in the selected column.

Nullable

Identifies whether or not a column is nullable.



Query Command History dialog

This dialog, displayed by selecting the Command History... command from the Query menu, allows you 
to view and select all of the ODBC (SQL) statements that have been executed in the current session. 
When the current ODBC Manager session is ended, the last 10 statements are saved and restored the 
next time ODBC Manager is executed

Insert String
Enabled if an SQL command is selected, this button inserts the selected SQL command into the Query 
Edit pane and dismisses the dialog. Double-clicking on a statement has the same effect. Any text which
is selected in the Query Edit Pane will be replaced by the statement. If no text is selected, the 
statement will be inserted at the current cursor position. The SQL command can then be executed by 
selecting the Execute Query command from the Query menu.



ODBC Data Types dialog

This dialog, displayed by clicking the Driver ODBC Data Types... command shows details about the 
ODBC data types supported by the current data source.

ODBC Data Type
Displays the ODBC SQL data type which are valid for the current ODBC driver.

API Number
Identifies the ODBC constant associated with the selected Data Type (These values are defined in the 
sql.h or sqlext.h that comes with the ODBCSDK).

Data Type
Identifies the ODBC SQL data type associated with the ODBC Data Type.

Precision
Identifies the precision of the selected ODBC SQL data type. This is the maximum precision of the data 
type on the data source. NULL is displayed for data types where precision is not applicable.

Literal Prefix
Identifies the character or characters used to prefix a literal. For example, a single quote () is used for 
character data types and 0x is used for binary data types. NULL is displayed for data types where a 
literal prefix is not applicable.

Literal Suffix
Identifies the character or characters used to terminate a literal. For example, a single quote () is used 
for character data types. NULL is displayed for data types where a literal suffix is not applicable.

Create Param
CREATE_PARAMS for DECIMAL would be "precision,scale", CREATE_PARAMS for VARCHAR would 
equal "max length"; NULL is displayed if there are no parameters for the data type definition (for 
example, INTEGER).
The driver supplies the CREATE_PARAMS text in the language of the country where it is used.

Nullable
Specifies whether or not the selected ODBC SQL accepts a NULL value.
Case Sensitive
Specifies whether or not the selected ODBC SQL data type is case sensitive with respect to collation. 
Displays TRUE if the data type can be treated as case sensitive.

Searchable
Specifies how the selected ODBC SQL data type is used in a where clause. The following summarizes 
the possible values:

SQL_UNSEARCHABLE = 0: The data type cannot be used in a WHERE clause.
SQL_LIKE_ONLY = 1: The data type can be used in a WHERE clause only with the LIKE 

predicate.
SQL_ALL_EXCEPT_LIKE = 2: The data type can be used in a WHERE clause with all 

comparison operators except LIKE.
SQL_SEARCHABLE = 3: The data type can be used in a WHERE clause with any comparison 

operator.

Money
Specifies whether or not the selected ODBC SQL is a money data type. Displays    1=TRUE if it is a 
money data type.



Unsigned Attrib.
Specifies whether or not the selected ODBC SQL is UNSIGNED.

Auto Increment
Specifies whether or not the selected ODBC SQL is autoincrementing. Displays 1=TRUE if the data 
type is autoincrementing, NULL if the attribute is not applicable.

Local Type Name
This is the localized version of the data source-dependent name of the data type. NULL is returned if a 
localized name is not supported by the data source.

Minimum Scale
Identifies the minimum scale associated with the selected ODBC SQL data type. This information is 
only applicable to ODBC 2.0 drivers.

Minimum Scale
Identifies the minimum scale associated with the selected ODBC SQL data type. This information is 
only applicable to ODBC 2.0 drivers.



Current ODBC Driver Information dialog

This dialog, displayed by clicking the Display Driver Info... command shows details about the currently 
installed ODBC driver.

Information Type
Lists the categories of information associated with the current ODBC driver.

Get Info No.
The number of the selected Information Type. Numbers from 1 to 999 are reserved by ODBC. Numbers
between 1000 and 64000 can be reserved for use by specific drivers.

Return Code
Displays a return code resulting from the request for information from the driver. The possible values 
are:
SQL_SUCCESS, SQL_SUCCESS_WITH_INFO, SQL_ERROR, or SQL_INVALID_HANDLE.

Results
The driver information for the selected information type.

Interpretation
Data associated with the result. For example, the information type SQL_ODBC_API_CONFORMANCE 
for a driver might return a SQL_SUCCESS code with a result of 0x00000001. This result would be 
interpreted as SQL_OAC_LEVEL1, that is the driver is ODBC Level 1 compliant. For specific details on 
each information type, refer to your Microsoft ODBC 2.0 Programmers Reference and SDK Guide.



Trace Options dialog

This dialog, displayed by selecting the Options... command from the Trace menu, allows you to specify 
the shows details about the currently installed ODBC driver.

Trace API Filter
Allows you to select the SQL function call or calls which will be traced by ODBC Manager. This includes
whether you want the filter set to the Core, level 1, or level 2 ODBC commands.

Trace Options
Specify the trace display options. Minimizing ODBC Manager or tracing to the top of the Trace pane will
allow faster execution of SQL commands since less time is used to update the information displayed in 
the trace pane.

Trace Output To
Select where you want the trace output to begin scrolling from. This can be either the Top, Center, or 
Bottom of the Trace pane. To allow faster execution, the center of the Trace pane works most efficiently.

Trace Log Against Task
Select the currently executing tasks against which to trace. Using the Show Tasks as EXE Names 
Only check box, the list of tasks can be displayed as full program names or simply as the name of the 
executing .EXE file. You can also check the Trace Against All Tasks check box which enables tracing 
against tasks that are currently running, and any tasks that are started while the trace is running.

Trace File Options
Check the Log To File check box to log trace information to a file and, if so, specify the filename. Note 
that Trace Analysis cannot be performed if the trace output is logged to a file. Check the Log Against 
EXE check box to trace against a specific executable. If the executable is not already running, ODBC 
Manager will start it for you.



Output Options dialog

This dialog, displayed by clicking the Save... command or the Print... command on the File menu allows
you to specify which information you want to print or save.

Output Contents of Trace Pane
The contents of the Trace pane will be saved or printed. If there is no information in this pane, this 
option cannot be selected.

Output Contents of Query Pane
The contents of the Select Query pane will be saved or printed. If there is no information in this pane, 
this option cannot be selected.



Search dialog

This dialog, displayed by selecting the Find... command on the Edit menu allows you to specify the 
search text and criteria for the information you want find.

Text
The text string which you want to find.

Match Case
Finds only those occurrences with the exact combination of uppercase and lowercase letters specified 
in the Text box.

Search Trace Pane
Specifies the Trace pane as the pane which will be searched for occurrences of the text specified in the 
Text box.

Search Query Pane
Specifies the Select Query pane as the pane which will be searched for occurrences of the text 
specified in the Text box.



Trace Analysis Options dialog

The Trace Analysis dialog, displayed by selecting the Trace Analysis... command from the Trace menu, 
allows you to analyze the time taken by each task for each API and highlight specific types of 
information. This dialog can only be displayed if tracing has been stopped.
The total time taken by each API, the number of times each API is called and the average time for each 
API is summarized and sorted as desired. Information for each task being traced is displayed 
separately in the Trace pane.

Task
Select one of the data sources defined on your system.

Sort By
Specifies the criterion by which the tasks are displayed. For the selected criterion, the list can be 
displayed in either ascending or descending order.

ODBC API - The list is grouped by the APIs called.
Call Count - Enter your user name. A user name can contain up to eight characters.
Time - The list is sorted according to the duration of the tasks.

Print...
Displays the Print dialog which allows you to print the analysis list.

Highlight ODBC Specifics
Allows you to highlight specific traced API calls, calls which take a certain amount of time (e.g., <10 ms,
>1000 ms etc.) and calls which have certain return codes. Highlighting colors can be defined by the 
Color dialog. which is displayed by clicking on the Set Color... button. Once highlighting colors are 
defined, they are applied to the data in the Trace pane.



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open. This box lists files with the extension you select in the List
Files of Type box. 

List Files of Type
Select the type of file you want to open:

Drives
Select the drive in which ODBC Manager stores the file that you want to open. 

Directories
Select the directory in which ODBC Manager stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



File Save As dialog

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name. A filename can contain up to eight 
characters and an extension of up to three characters. ODBC Manager adds the extension you specify 
in the Save File As Type.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Font dialog

This dialog, displayed by selecting the Font... command from the Edit menu allows you to replace the 
current font with any other installed font.

Font
Type or select a font name. The lists contains the fonts available with the current printer driver and 
additional fonts installed in your system.

Font Style
Select a style. The styles available depend on the font selected. To use the default type style for a given
font, select Regular.

Size
Type or select a size. The sizes available depend on the printer and the selected font. If the size you 
type is not available on the current printer, the closest available size will be chosen.

Sample
Shows a sample of the font you specify before you apply it.



Color dialog

This dialog, displayed by clicking the Set Color... button in the Trace Analysis Options dialog allows you 
to select specific highlight colors for trace conditions which you have identified.

Basic Colors
A palette of preset colors for your screen. Choose one as your highlight color.

Custom Colors
A palette of available custom designed colors. Choose one as your highlight color.





ALTER TABLE

Syntax
ALTER    TABLE    [creator.]table-name

| ADD    column-definition    [column-constraint ...] |
| ADD    table-constraint |
| MODIFY    column-definition |
| MODIFY    column-name    DEFAULT    default-value |
| MODIFY    column-name    [ NOT ] NULL |

. . . | DELETE    column-name | , . . .
| DELETE    CHECK |
| DELETE    UNIQUE    ( column-name, ... ) |
| DELETE    PRIMARY KEY |
| DELETE    FOREIGN KEY role-name |
| RENAME    new-table-name |
| RENAME    column-name    TO    new-column-name |

column-definition:
                  column-name data-type [ NOT NULL ] [ DEFAULT default-value ]

column-constraint:
| UNIQUE |
| PRIMARY    KEY |
| REFERENCES table-name [( column-name )] |
| CHECK    ( condition ) |

default-value:
| string |
| number |
| NULL |
| CURRENT DATE |
| CURRENT TIME |
| CURRENT TIMESTAMP |
| USER |

table-constraint:

| UNIQUE    ( column-name, ... ) |
| PRIMARY    KEY    ( column-name, ... ) |
| CHECK    ( condition ) |
| foreign-key-constraint |



foreign-key-constraint:

[NOT NULL]    FOREIGN KEY    [role-name]    [(column-name, ... )]

. . . REFERENCES table-name [(column-name, ... )]

. . . [ CHECK ON COMMIT ]

Description
Modifies a tables column definitions and table constraints.

Usage
All.

Authorization
Must be the creator of the table or have DBA authority.



BEGIN SUBTRANSACTION

Syntax
BEGIN SUBTRANSACTION [subtransaction-name]

Description
Begins a subtransaction within the current transaction.

Usage
All.

Authorization
None.



COMMIT

Syntax
COMMIT WORK

Description
Ends a transaction and makes permanent any changes to a database.

Usage
All.

Authorization
Must be connected to the database.



CREATE DBSPACE

Syntax
CREATE DBSPACE [creator.]dbspace-name AS filename

Description
Create a new database file. The file can be located or another machine thus allowing the database to 
be spread between more than one machine.

Usage
All.

Authorization
DBA.



CREATE INDEX

Syntax
CREATE    [UNIQUE]    INDEX    [creator.]index-name

. . .    ON    [creator.]table-name

. . .    ( column-name    [ ASC | DESC ], ... )

Description
Creates an index on the specified table in order to optimize query speed.

Usage
All.

Authorization
DBA or table creator.



CREATE TABLE

Syntax
CREATE    TABLE    [creator.]table-name

. . . ( | column-definition [ column-constraint ... ] |, ... )
| table-constraint |

. . . [IN    [creator.]dbspace-name]

column-definition:
column-name data-type [ NOT NULL ] [ DEFAULT default-value ]

column-constraint:
| UNIQUE |
| PRIMARY    KEY |
| REFERENCES table-name [( column-name )] |
| CHECK    ( condition ) |

default-value:
| string |
| number |
| NULL |
| CURRENT DATE |
| CURRENT TIME |
| CURRENT TIMESTAMP |
| USER |

table-constraint:
| UNIQUE    ( column-name, ... ) |
| PRIMARY    KEY    ( column-name, ... ) |
| CHECK    ( condition ) |
| foreign-key-constraint |

foreign-key-constraint:
[NOT NULL]    FOREIGN KEY    [role-name]    [(column-name, ... )]

. . . REFERENCES table-name [(column-name, ... )]

. . . [ CHECK ON COMMIT ]

Description



Creates a new table in the database.

Usage
All.

Authorization
To create your own new table you must have RESOURCE authority. To create tables for other users, 
you must have DBA authority.



CREATE VARIABLE

Syntax
CREATE VARIABLE identifier data-type

Description
Creates a SQL variable of a specified name and data type. The variable initially has a NULL value and 
may be changed using SET VARIABLE.

Usage
All.

Authorization
None.



CREATE VIEW

Syntax
CREATE VIEW [creator.]view-name [( column-name, ... )]

. . . AS select-without-order-by

Description
Creates a new view of the database providing a different way of looking at the data.

Usage
All.

Authorization
To create your own new view you must have RESOURCE authority and SELECT permission on the 
relevant tables. To create views for other users, you must have DBA authority.



DELETE

Syntax
DELETE    FROM    [creator.]table-name    [WHERE    search-condition]

Description
Deletes rows satisfying the specified criteria from the database.

Usage
All.

Authorization
Must have DELETE permission on the table which contains the rows.



DESCRIBE

Syntax
DESCRIBE

| SELECT LIST FOR |
. . . [ | OUTPUT |          ]

| BIND VARIABLES FOR |
| INPUT|

. . . statement-name    INTO    sqlda-name

statement-name: identifier, or host-variable
sqlda-name: identifier

Description
Returns information about variables used by the host to pass or accept database data.

Usage
Embedded SQL.

Authorization
None.



DROP

Syntax

| DBSPACE    [creator.]dbspace-name |
DROP | INDEX    [creator.]index-name |

| TABLE    [creator.]table-name |
| VIEW    [creator.]view-name |

Description
Removes indexes, tables, dbspaces and views from the database. DROP TABLE implicitly drops the 
specified tables indexes and keys and deletes the tables data. DROP DBSPACE requires that the 
tables in the specified dbspace are first dropped.

Usage
All.

Authorization
Must be creator of the index, table or view. However DBA    authority is required to execute DROP 
DBSPACE.



DROP VARIABLE

Syntax
DROP    VARIABLE    identifier

Description
Eliminates an SQL variable prior to disconnection of the database. This can be useful in freeing up 
system resources occupied by large variables.

Usage
All.

Authorization
None.



END SUBTRANSACTION

Syntax
END SUBTRANSACTION [subtransaction-name]

Description
End a subtransaction (previously initiated by a BEGIN SUBTRANSACTION command) within the 
current transaction. If the name of the subtransaction is not specified, the last initiated subtransaction is 
ended.

Usage
All.

Authorization
The current transaction must have contained a corresponding BEGIN SUBTRANSACTION command.



EXECUTE

Syntax
Format 1:

EXECUTE    statement-name

. . . [ | USING DESCRIPTOR sqlda-name |          ]
| USING host-variable-list |

statement-name: identifier, or host-variable
sqlda-name: identifier

Format 2:

EXECUTE    IMMEDIATE    statement

statement: string, or host-variable

Description
Executes a SQL statement.

Usage
Embedded SQL.

Authorization
Depends on the statement to be executed.



FROM

Syntax
. . . FROM    table-expr, ...

table-expr:

|    table-spec |
|    table-expr    join-type    table-spec    [ ON condition ] |
|    ( table-expr, ... ) |

table-spec:

[userid . ] table-name [ [AS] correlation-name ]

join-type:

|    CROSS JOIN |
|    [ NATURAL | KEY ] JOIN |
|    [ NATURAL | KEY ] INNER JOIN |
|    [ NATURAL | KEY ] LEFT OUTER JOIN |
|    [ NATURAL | KEY ] RIGHT OUTER JOIN |

Description
Specifies the database tables or views involved in a SELECT or UPDATE 
statement.

Usage
All.

Authorization
Must have a database connection.



GRANT

Syntax
Format 1:

GRANT    CONNECT TO    userid,...    IDENTIFIED    BY    password,...

Format 2:

| DBA |
GRANT | 
RESOURCE |

| GROUP |
| MEMBERSHIP IN GROUP userid,... |

. . .      TO    userid,...

Format 3:

| ALTER |
| DELETE |
| INSERT |

GRANT | 
REFERENCES |    ,...

| SELECT |
| UPDATE    [(column-name,...)] |
| ALL    [PRIVILEGES] |

. . .      ON    [creator.]table-name    TO    userid, ...    [WITH GRANT OPTION]

Description
Assigns permissions and creates Ids for new users.

Usage
All.

Authorization
For Format 1 or 2, must:

· be changing your own password using GRANT CONNECT,
· be adding members to your own userid, or,



· have DBA authority.

For Format 3, must have:

· created the table, or
· been granted permissions on the table with GRANT OPTION, or,
· DBA authority.



INCLUDE

Syntax
INCLUDE    filename

filename: identifier

Description
Includes a file as part of the information to be read by the SQL source language preprocessor.

Usage
Embedded SQL.

Authorization
None.



INSERT

Syntax
Format 1:

INSERT    INTO    [creator.]table-name    [( column-name, ... )]

. . .    VALUES    ( expression, ... )

Format 2:

INSERT    INTO    [creator.]table-name    [( column-name, ... )]

. . .    select-statement

Description
To insert a single row (format 1) or a selection of rows from elsewhere in the database (format 2) into a 
table.

Usage
All.

Authorization
INSERT permission on the specified table.



OPEN

Syntax
OPEN    cursor-name

. . .    [ |USING DESCRIPTOR    sqlda-name |          ]
| USING host-variable, ... |

. . .    [ WITH HOLD ]    [ ISOLATION LEVEL n ]    [ BLOCK n ]

cursor-name: identifier, or host-variable
sqlda-name: identifier

Description
To open a previously declared cursor to access information from the database.

Usage
Embedded SQL.

Authorization
SELECT permission on all tables in the specified cursor.



ROLLBACK

Syntax
ROLLBACK    WORK

Description
Undoes any changes made since the last COMMIT or ROLLBACK. It removes any changes made 
during this transaction.

Usage
All.

Authorization
Must have a database connection.



ROLLBACK SUBTRANSACTION

Syntax
ROLLBACK SUBTRANSACTION [subtransaction-name]

Description
To cancel any changes made since a BEGIN SUBTRANSACTION. It removes any changes made 
during this subtransaction.

Usage
All.

Authorization
The current transaction must not have ended and there must have been a corresponding BEGIN 
SUBTRANSACTION within it.



SELECT

Syntax
SELECT    [ ALL | DISTINCT ]    select-list

. . . [ INTO    host-variable, ... ]

. . . FROM    table-list

. . . [ WHERE    search-condition ]

. . . [ GROUP    BY    column-name, ... ]

. . . [ HAVING    search-condition ]

. . . | [ ORDER    BY    expression    [ ASC | DESC ], ...    ] |

. . . | [ ORDER    BY    integer    [ ASC | DESC ], ...    ] |

select-list:
|    table-name.* |, ...
|    expression [ AS alias-name ] |
|    * |

Note: INTO clause used in Embedded SQL only

Description
To retrieve information from the database.    Also, used in ISQL to export data 
from the database to an external file.

Usage
All (INTO clause used in Embedded SQL only).

Authorization
Must have SELECT permission on the named tables and views.



SET CONNECTION

Syntax
SET CONNECTION    [connection-name]

connection-name: identifier, string or host-variable

Description
To change the active database connection.

Usage
Embedded SQL

Authorization
None.



SET OPTION

Syntax
1. SET    [ TEMPORARY ]    OPTION

. . .        [ userid. | PUBLIC. ]option-name = [ option-value ]

2. SET    PERMANENT

3. SET

userid: identifier, string or host-variable
option-name: identifier, string or host-variable
option-value: host-variable (indicator allowed), string, identifier, or 
number

Note:    Formats 2 and 3 are ISQL only.

Description
To change database options.

Usage
All (format 1), ISQL (all formats).

Authorization
None required to set your own options.    Must have DBA authority to set 
options for another user or PUBLIC.



SET

Syntax
SET    identifier    =      expression

Description
To assign a value to a SQL variable.

Usage
All.

Authorization
None.



SYSTEM

Syntax
SYSTEM    [ operating-system-command ]

Description
To execute an operating system command from within ISQL.

Usage
ISQL (DOS and QNX only).

Authorization
None.



UNION

Syntax
select-without-order-by    UNION    [ALL]    select-without-order-by

. . .    [    UNION    [ALL]    select-without-order-by ] ...

. . .    [ ORDER    BY    integer    [ ASC | DESC ], ...    ]

Description
To combine the results of two or more select commands.

Usage
All.

Authorization
Must have SELECT permission for each of the component SELECT 
commands.



UPDATE

Syntax
UPDATE    table-list    SET

. . .    column-name = expression, ...

. . .    [ WHERE    search-condition ]

. . .    [ ORDER BY    expression    [ ASC | DESC ] ,... ]

Description
Modifies data in the database.

Usage
All.

Authorization
UPDATE permission for the columns being modified.



VALIDATE TABLE

Syntax
VALIDATE TABLE [creator.]table-name

Description
Traverses a tables rows and looks up each row in each index on the table. VALIDATE TABLE will return
an error if the database file is corrupt. In the case of corruption, recreate the tables indexes and keys or 
reload the database.

Usage
All.

Authorization
DBA or table creator



Getting Help on SQL Keywords

If there is an SQL statement present in the Query Edit pane then help can be accessed on any of the 
keywords contained in that statement. 

To get help on an SQL Keyword:
1. Select the keyword from the Query Edit pane using the keyboard or by double clicking on it with the

left mouse button. Note that more than one word can be selected. For example, BEGIN 
SUBTRANSACTION is a valid keyword.

2. Press F1.
If the selected text is a valid keyword, information on the keyword and its usage will display in a help 
window. If the selected text is not a valid keyword then general help on the Query Edit window will be 
displayed.



Tracing Against one, Multiple, or all Tasks

Tracing against a task allows you to monitor the SQL calls that a particular task makes to the data 
source to which you are connected. ODBC Manager allows you to trace against a selected task or 
tasks or against all tasks being executed at any given time. The trace information can the be analyzed, 
saved or printed. 

To trace against a task:
1. Connect to the required data source.
2. Ensuring that the desired Trace API filter has been constructed, select the task or tasks against 

which you want to trace in the Trace Options dialog. To select a task which is currently running, 
click on its name. To deselect a task, click on its name while holding down the CTRL key. To trace 
against all tasks (including tasks which are not currently running), check the Trace Against All Tasks
check box. Press OK.

3. To initiate the trace, select the Start command from the Trace menu.
Any interactions between the selected task or tasks and the connected data source will be reflected in 
the Trace pane. 
To temporarily suspend a trace, choose the Pause command from the Trace menu.
To terminate a trace, choose the Stop command from the Trace menu.



Saving Data

Ranges or entire sections of data from the Trace pane, the Select Query pane, or both of these panes 
can be saved.

To save data:
1. If you want to save only a selection of data, select the data you want to save.
2. Select the Save... command from the File menu. The Output Options dialog will be displayed.
3. Choose the window or windows from which you want information to be saved and click OK.
The name and location of the output file can be specified in the Save dialog. 



Printing Data

Ranges or entire sections of data from the Trace pane, the Select Query pane, or both of these panes 
can be printed.

To save data:
1. If you want to print only a selection of data, select the data you want to print.
2. Select the Save... command from the File menu. The Output Options dialog will be displayed.
3. Choose the window or windows from which you want information to be printed and click OK.
The Print dialog will display allowing you to specify print options.



Connecting to a Data Source

Connecting to a data source allows you to execute a range of queries against it. In addition, information
about the database can be viewed.

To connect to a data source:
1. Choose the Connect... command from the Query menu. This displays the ODBC Data Source 

Connect dialog.
2. Select the required data source name and enter the user name and password if required by the 

database.
If an invalid name or password is specified, the connection to the database will fail.





Precision
Identifies the maximum number of digits used by the data type of a numeric column or parameter. For a
nonnumeric column or parameter, the value is usually either the maximum length or the defined length.



ODBC SQL data type
Valid data types are Minimum where a basic level of ODBC conformance is provided, Core which are 
compliant to the X/Open and SQL Access Group SQL CAE specification (1992) or Extended which are 
provided by some SQL data sources.



Scale

The scale of a numeric column or parameter refers to the maximum number of digits to the right of the 
decimal point. Note that, for approximate floating point number columns or parameters, the scale is 
undefined, since the number of digits to the right of the decimal place is not fixed.



Radix

Can be 10 (decimal) or 2 (binary). If it is 10, the values in PRECISION and SCALE give the number of 
decimal digits allowed for the column. For example, a DECIMAL(12,5) column would return a RADIX of 
10, a PRECISION of 12, and a SCALE of 5.

If it is 2, the values in PRECISION and SCALE give the number of bits allowed in the column. For 
example, a FLOAT column could return a RADIX of 2, a PRECISION of 53, and a SCALE of NULL.

Note that, for numeric data types, the data source and driver can return a RADIX of either 2 or 10. For 
example, a FLOAT column could return a RADIX of 10, a PRECISION of 15 and a SCALE of NULL.

NULL is returned for data types where radix is not applicable. 



Nullable
With respect to nullability, a column can have one of three attributes:

SQL_NO_NULLS if the column does not accept NULL values.
SQL_NULLABLE if the column accepts NULL values.
SQL_NULLABLE_UNKNOWN if it is not known if the column accepts NULL values.



Compound SQL Statement
An SQL statement comprising more that one SQL command separated by semi-colons. For example:
UPDATE student SET Studname='BOB' where Studnum=86005;
UPDATE student SET Studname='EDDIE' where Studnum=86006;
UPDATE student SET Studname='MAT where Studnum=86007;
                                                                            . . . . . . . . .
                                                                            . . . . . . . . .
SELECT * from student



ODBC Administrator
Allows you to add, modify, or delete ODBC drivers and data sources.






